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Ведение 
 
Внедрение вычислительной техники на предприятиях является необходимостью. В настоящее время страна 

находится на пороге вступления в ВТО и предприятия должны производить продукцию способную конкурировать с 
западной. Для этого требуется внедрение новых технологий на предприятиях, то есть закупка нового оборудования и 
программного обеспечения. Современные САПР немыслимы без широкого использования интерактивной машинной 
графики. Эволюция в САПР и ЭВМ привела к появлению математических моделей, которые превратились в систему 
твердотельного моделирования. Выгоды применения САПР очевидны: 

 Повышение производительности труда конструкторов. Достигается благодаря ЭВМ, которая 
обеспечивает представление о разрабатываемом изделии и его составных частях, а так же сокращает 
время разработку, синтез, анализ и документирование проектных решений. 

 Улучшение качества проектов. Благодаря наглядному представлению разрабатываемого изделия. 
САПР предоставляет широкие возможности для глубокого инженерного анализа, уменьшается 
количество ошибок проектирования благодаря высокой точности САПР. 

 Совершенствование информационного общения разработчиков. В настоящее время САПР 
предоставляет возможность совестной работы группы разработчиков, передача информации 
производится при помощи сети, что существенно сокращает сроки проектирования, позволяет 
выявлять ошибки на стадии проектирования. 

 Формирование базы данных для системы управления производством.  
 Современные САПР позволяют управлять процессом проектирования, отлеживать «жизненный путь» 
изделия от начала и до конца и при необходимости вносить коррективы. 

Pro/Engineer считается «тяжелой» системой и полный пакет этой программы стоит не дешево, однако это 
окупается многофункциональность системы. Pro/Engineer позволяет: 

 Создавать конструкторскую документацию (3D модели, сборки, чертежи) 
 Создавать обработку для станков с ЧПУ (создание обработки, симуляция процесса обработки, 
контроль зарезов, вывод управляющей программы) 

 Проводить различные анализы 
 Создавать элементы пресс-форм, литейных форм, штампов (модуль Mold) 

В данной работе рассмотрены возможности Pro/Engineer Wildfire и других CAD/CAM систем, созданы 3D 
модели корпуса прибора ночного видения и формообразующих элементов пресс-формы (неподвижная матрица, 
пуансон, подвижная матрица), создана сборка корпуса и формообразующих элементов пресс-формы, создана ЧПУ 
обработка формообразующих элементов пресс-формы в среде Pro/Engineer Wildfire 2.0, созданы файлы управляющих 
программ. 
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1   Обзор CAD/CAM систем 
 
CAD (Computer Aided Design) – конструкторские САПР, применяются для создания конструкторской 

документации. CAM (Computer Aided Manufacturing) – САПР ЧПУ, применяются для разработки управляющих 
программ. CAPP (Computer Aided Process Planning) – технологические САПР, применяются для разработки 
технологической документации (получение операционных и маршрутных карт). 

На сегодняшний день наиболее распространенными CAD/CAM системами на отечественном рынке являются: 
T-FLEX, ADEM, Компас 3D, Cimatron, Solidworks, Pro/Engeneer. Первые три системы разработаны отечественными 
производителями, остальные зарубежными. 

1.1   T-FLEX 
 
T-FLEX – продукт отечественной компании «Топ Системы». Компания официально начала выпуск продукции в 

1992 году, выпустив коммерческую версию системы T-FLEX CAD 2.x (TOP CAD). С тех пор компания регулярно 
(практически ежегодно) выпускает новые продукты и дополнения. 

 
Рисунок 1.1 – Официальный сайт компании «Топ Системы» 

Отличительные особенности продуктов T-FLEX 
 Решение широчайшего спектра задач автоматизации технической подготовки производств с помощью 

систем T-FLEX от одного разработчика - компании «Топ Системы», является уникальным предложением на 
российском рынке. 

 Все системы, входящие в комплекс, полностью интегрированы между собой. Передача информации от 
одной системы к другой осуществляется в едином информационном пространстве, за счет внутренней связи между 
модулями. Это позволяет осуществить сквозной информационный поток данных проекта, что является необходимым 
условием распараллеливания конструкторских и технологических работ и является базой для организации PLM-
технологий управления информацией по всему жизненному циклу изделий. 

 Комплекс содержит передовые российские разработки в соответствующих областях автоматизированного 
проектирования, которые учитывают специфику российского производства (стандарты, технические условия, 
оборудование и т.д.). Эти разработки сочетаются с лучшими мировыми математическими и программными 
технологиями, используемыми при создании систем комплекса. 

 Широкая поддержка международных стандартов. Сохранение неизменного вида документа в различных 
языковых версиях операционной системы. 

 Обширные библиотеки стандартных элементов (крепеж, подшипники, соединения, уплотнения и т.п.), 
единая база данных технического и технологического оснащения, структурированный доступ к структуре изделия и 
другая подобная информация. 

 Каждая из систем может работать как в едином комплексе, так и в любой комбинации или в автономном 
режиме, что позволяет гибко и поэтапно решать задачи оснащения средствами автоматизации подготовки 
производства на любом предприятии. 

 Комплекс обеспечивает надежную защиту технической информации от несанкционированного доступа и 
распространения. 

 Наличие модуля технологической подготовки производства, глубоко интегрированного с системой 
проектирования изделия, делает комплекс уникальным на рынке средств автоматизации проектирования и подготовки 
производства. 
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2 Исследовательская часть 

2.1   Создание 3D модели средствами Pro/Engineer Wildfire 2.0 
 
Для создания новой детали в падающем меню File выбирается пункт New или нажимается иконка на панели 

инструментов, имеющая аналогичное название. Следствием этого действия является появление окна имеющего 
аналогичное название (New), в котором имеются два столбца. В левом столбце (Type) выбирается пункт Part, в правом 
(Sub-type) Solid. В графе Name можно указать имя файла (латинским шрифтом), который сохраняется по умолчанию в 
папке «parts», директории «PTS». После этого откроется пространство для моделирования. В левой части экрана 
располагается дерево построения, сверху и справа панели инструментов, снизу расположена информационная строка, 
которая в ряде случаев преобразуется в командную. Дерево построения  имеет иерархическую структуру. На верхней 
ступени расположена деталь (имя файла), ниже расположены элементы данной детали (эскизы, операции). На 
начальном этапе моделирования дерево построения содержит основные плоскости (RIGHT, TOP, FRONT) и точку 
начала системы координат. Начальным этапом для создания любой модели является выбор базового элемента детали. 
Для этого деталь необходимо проанализировать. Выбор базового элемента является ключевым моментом в создании 
модели, так как от этого выбора зависти количество операций применяемых при создании модели. После выбора 
базового элемента деталь анализируется на наличие вспомогательных элементов, которые строятся на основе или с 
использованием базового. После проведения анализа можно приступать к непосредственному созданию модели. 
Первый этап – создание эскиза базового элемента. Второй этап – создание базового элемента, осуществляется при 
помощи операций выдавливания (Extrude), вращения (Revolve), кинематического выдавливания (Variable Section 
Sweep), выдавливания по сечениям (Blend). Третий этап – создание вспомогательных элементов, причем 
вспомогательные элементы могут создаваться при помощи эскизых и безэскизных операций, таких как скругление 
(Round), фаска (Chamfer), создание отверстия (Hole), уклон (Draft), создание оболочки (Sell) и др. 

 

2.1.1   Создание эскиза. Этапы создания эскиза 
 
Процесс создания эскиза заключается в выборе эскизной плоскости, создании на ней геометрии эскиза и 

простановке размеров. 
Создание эскиза выполняется поэтапно в следующей последовательности: 

1) Выбор операции эскизирования. Необходимо выбрать иконку создания эскиза  (Sketch Tool), 
расположенную на панели инструментов. 

2) Выбор эскизной плоскости. В качестве плоскости эскизирования может выступать опорная плоскость или 
плоская поверхность. После выбора плоскости, Pro/ENGINEER автоматически установит плоскость эскизирования 
параллельно экрану. Для выбора эскизной плоскости необходимо указать ее левой кнопкой мыши, при этом 
выбранная плоскость подсвечивается красным цветом. Этот шаг сопровождается появлением окна Sketch (рис. 2.1). 

В этом окне указывается плоскость эскизирования и ее 
ориентация. В графе Plane указана плоскость эскизирования выбранная 
ранее. Первая строка в разделе ориентация эскиза – направление 
«взгляда» на эскиз. Направление изображается в виде желтой 
стрелочки, примыкающей к плоскости эскизирования. Направление 
взгляда меняется при помощи кнопки Flip или интерактивно (мышкой 
изменяется направление стрелки). Следующая строка Reference, в ней 
указывается плоскость или поверхность перпендикулярная эскизной. 
Только после того как все эти строки будут заполнены, появится 
возможность нажать кнопку ОК. Обычно эта информация 
проставляется автоматически и кнопка ОК доступна. 

3) Выбор базовых элементов. Система автоматически наносит 
размеры на все геометрические примитивы созданные в эскизе, 
поэтому ей необходимы базовые элементы, относительно которых 
будут проставляться размеры. Для указания базовых поверхностей 
служит окно References (рис. 2.2), которое появляется сразу после окна Sketch. 

Выбор элементов производится при помощи мыши. Данный 
шаг обязателен, иначе система не сможет расположить эскиз, о чем 
будут сигнализировать предупреждения. Данный шаг заменяет 
операцию проецирования, так как позволяет спроецировать на 
эскизную плоскость прямые точки, а так же поверхности 
перпендикулярные плоскости эскиза. 

4) Создание геометрии в эскизе. На данном этапе производится 
создание эскиза при помощи геометрических примитивов и 
стандартных операций, таких как усечение, зеркальное отображение, 
копия и т.д. Виды операций, участвующих при создании эскиза 
приведены в таблице 2.1 

 
Рисунок 2.1 – Создание эскиза 

 
Рисунок 2.2 - Выбор базовых элементов 
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Таблица 2.1 – Операции, используемые при создании эскиза 

 
Иконка Обозначение Иконка Обозначение 

 Выбор элемента  Сплайн 

 Прямая по двум точкам  Точка 

 Прямая касательная к двум элементам  Вспомогательная система координат 

 Осевая линия  Простановка размера 

 Прямоугольник  Усечение 

 Окружность по центру и точке на ней  Продление объекта 

 Окружность по трем точкам  Разбиение объекта на части 

 Окружность по трем касательным элементам  Задание связей между элементами эскиза 

 Концентрическая окружность  зеркальное отображение 

 Элипс  Поворот 

 Дуга по трем точкам  Копия 

 Дуга по центральной и концевым точкам  Текст 

 Дуга касательная трем элементам  Подтверждение создания эскиза 

 Создание элиптической дуги  Отмена эскиза 

 Скругление  Построение элемента по ребру 
5) Наложение геометрических ограничений на эскиз. На элементы эскиза накладываются такие ограничения 

как параллельность, перпендикулярность, колинеарность и др. Этот шаг выполняется для того, чтобы сделать эскиз 
более предсказуемым при его изменении. Желательно выполнять этот шаг до нанесения размеров, так как после 
нанесения ограничений количество проставляемых размеров уменьшается, следовательно сокращается время на 
создание эскиза. 

6) Образмеривание эскиза. При создании нового или изменении уже существующего геометрического 
примитива система автоматически проставляет размеры. Они отображаются на экране серым цветом. Но часто 
размерная схема предоставляемая системой не устраивает пользователя, в этом случае пользователь проставляет 
размеры вручную. Эти размеры имеют желтый цвет и являются приоритетными по сравнению с размерами, 
имеющими серый цвет. Если эти размеры войдут в противоречие, то система выберет приоритетный размер, а другой 
удалит. Простановка любых размеров осуществляется по следующему принципу: 

 на панели инструментов выбирается иконка  
 левой кнопкой мыши поочередно указывается два элемента, между которыми проставляется размер (в 
качестве элементов выступают точки прямые и дуги для простановки радиальных и диаметральных 
размеров) 

 после этого производится нажатие на колесо мыши в той части экрана, где будет располагаться размер. 
После простановки размеров эскиз приобретает законченный вид (рис. 2.3) и можно подтвердить создание 

эскиза, нажав на галочку.  
Создание линейных размеров 

Для создания линейного размера нужно выбрать линию, затем 
указать курсором место, где будет располагаться размер и нажать 
среднюю клавишу мыши. Для создания линейного размера между 
двумя линиями или точками, нужно выбрать первый элемент, выбрать 
второй элемент, затем указать курсором место, где будет располагаться 
размер, и нажать среднюю клавишу мыши. 

Создание угловых размеров 
Для создания углового размера нужно указать две 

непараллельные линии, затем место, где будет располагаться размер и 
нажать среднюю клавишу мыши. 

Создание радиальных размеров 
Для создания радиального размера на дуге или окружности, 

необходимо выбрать дугу или окружность, курсором указать место, 
где будет располагаться размер, и нажать среднюю клавишу мыши. 

Создание диаметральных размеров 
Для создания диаметрального размера на дуге или окружности, 

нужно дважды щелкнуть по дуге или окружности, указать курсором 
место, где будет располагаться  размер и нажать среднюю клавишу 

мыши. 

 
Рисунок 2.3 – Созданный эскиз 
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Для создания диаметральных размеров для точек (линий), нужно выбрать точку (линию), затем выбрать 
центральную линию (относительно которой будете создаваться диаметральный размер), затем снова эту же точку 
(линию). Указать курсором место, где система должна расположить размер и нажатт среднюю клавишу мыши для 
размещения размера.  

Модификация размеров с помощью масштабирования 

Можно быстро масштабировать все выбранные размеры с помощью иконки . В этом случае, изменение 
одного размера приведет к пропорциональному изменению других выделенных размеров. 

После создания эскиза можно приступить к выполнению операций, позволяющих получить необходимые 
элементы детали [12]. 

 

2.1.2   Наложение ограничений на геометрию при выполнении эскиза 
 
Наложение ограничений применяется при эскизировании для облегчения работы с эскизом. Если эскиз 

подвергнут данной операции, то на изменение его затрачивается меньше усилий. Наложение ограничений так же 
упрощает работу при создании эскиза. Панель Constraints имеет вид (рис. 2.4): 

 
Рисунок 2.4 – Панель Constraints 

Операции, используемые для наложения ограничений, представлены в таблице 2.2 
 

Таблица 2.2 – Операции , используемые для наложения ограничений 
 

Иконка Операция Иконка Операция 

 Вертикальность  Коллинеарность 

 Горизонтальность 
 

Симметрия 

 Перпендикулярность  Условие равной длины 

 
Касание  Параллельность 

 Средняя точка   
 
При наложении какого-либо условия на элемент данное наложение показывается в виде маленького значка 

расположенного рядом с элементом (рис. 2.5). 

 
Рисунок 2.5 – Отображение наложенных ограничений 

Кроме этого в Pro/Engineer присутствует трассировка и различные привязки, упрощающие работу по созданию 
эскиза. Если возникает неопределенность в намерении пользователя привязаться к какому-либо объекту, Pro/Engineer 
откроет окно с запросом. На запрос есть два варианта ответа «Yes» или «No», в случае первого ответа программа 
осуществит привязку, и не будет проставлять излишние размеры. В втором случае привязка осуществлена не будет. 

2.1.3   Операции, используемые при создании модели 
 
Основными операциями без сомнения являются операции выдавливания и вращения. Более того, именно эти 

операции наиболее часто применяются при создании базового элемента.  
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2.1.3.1   Создание эскизных фитчеров 
 
Эскизными являются фитчеры, которые были получены при помощи операций с использованием эскиза. 

Основными эскизными операциями являются: Extrude (Выдавливание), Revolve (Вращение), Variable Section Sweep 
(Люфтинг или Кинематическое выдавливание), Blend (Сопряжение или выдавливание по сечениям). Для создания 
двух последних операций требуется наличие более одного эскиза. Для создания операции Variable Section Sweep 
требуется два эскиза, один из которых выступает в качестве траектории, а другой в качестве «формообразующего 
элемента», то есть этот эскиз будет выдавливаться вдоль траектории. Для создания операции Blend используется 
более одного эскиза. Выдавливание осуществляется между эскизами, сопрягая их. 

Операция Extrude (Выдавливание) 
В основе операции Extrude лежит плоский эскиз. Этот эскиз выдавливается в пространство на определенную 

глубину по направлению, перпендикулярному плоскости эскизирования. С помощью этого инструмента можно 
создавать сплошное добавление материала или сплошной вырез, тонкостенное добавление материала или 
тонкостенный вырез, выдавливание как поверхность или обрезка поверхности. Данная операция является эскизной, те 
есть для ее выполнения необходимо иметь готовый эскиз. При наличии такового выбирается иконка на панели 

инструментов  (Extrude Tool). При этом командная строка преобразуется в окно редактирования выдавливания 
(рис. 2.6). 

 
Рисунок 2.6 - Панель редактирования выдавливания 

Как и во многих приложениях Windows, этапы создания выдавливания дублируются. То есть выдавливание 
можно создать при помощи падающего меню, расположенного в верхней части панели или при помощи иконок в 
нижней части или же используя и падающее меню и иконки. Первой стадией создания выдавливания является выбор 
объекта (эскиза), подлежащего выдавливанию. Если до выбора операции выдавливания эскиз был уже выбран (в этом 
случае он подсвечивается красным цветом) то первый шаг автоматически выполняется системой. При выборе меню 
Placement можно увидеть название эскиза участвующего в создании выдавливания. В меню Options указываются 
способы выдавливания. В меню Properties указывается имя операции, по умолчанию это Extrude и порядковый номер. 
Рассмотрим иконки и окна расположенные снизу. Первая иконка слева означает выдавливание «тела», далее 
выдавливание поверхности (создание тонкой стенки), далее способ выдавливания, глубина, направление, выбор 
материала (используется при вырезании выдавливанием). Способы выдавливания представлены в таблице 2.3 

 
Таблица 2.3 – Способы выдавливания 

Иконка Обозначение Иконка Обозначение 

 Выдавить на расстояние  Через все 

 Симметрично  До пересечения с выбранной поверхностью 

 До следующей поверхности  До плоскости, поверхности, точки 
Используя вышеперечисленные инструменты можно создать операцию выдавливания. Верным признаком того, 

что операция будет создана успешно, является отображение на экране будущего элемента желтым цветом (рис. 2.7). 
При этом иконка в виде галочки доступна. Если иконка не доступна это верный признак того, что не все условия 
операции соблюдены, в первую очередь стоит проверить эскиз, если он не выбран, то подсвечивается серо-голубым 
цветом. Если эскиз при выборе не выделяется, это означает, что он был создан с нарушениями, к примеру: не замкнут 
контур (в этом случае возможно создание тонкой стенки), либо во время операции усечения был забыт какой-либо 

кончик и т.д. Если иконка  доступна, но выдавливание не отображено, то возможно возникновение ошибки на 
этапе нажатия на иконку с галочкой. 

 
Рисунок 2.7 – Создание выдавливания 
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При создании выдавливания на расстояние это расстояние можно указать интерактивно, зажав и протащив на 
определенное расстояние белый квадратик. 

Операция  Revolve (Вращение) 
По сути, операция вращения мало отличается от выдавливания. Для выполнения данной операции необходим 

эскиз и строго одна ось вращения. В основе операции Revolve лежит плоский эскиз. Этот эскиз поворачивается на 
определенный угол относительно собственной или специально указанной оси вращения. С помощью этого 
инструмента можно создавать сплошное добавление материала или сплошной вырез, тонкостенное добавление 
материала или тонкостенный вырез, выдавливание как поверхности или обрезка поверхности. 

Порядок создания фичера инструментом Revolve (Вращение) со ссылкой на внешний эскиз: 
 Запуск инструмента Revolve (Вращение). 
 Выбор внешнего эскиза. 
 Выбор линейной ссылки (ось, линейная кромка), относительно которой система будет поворачивать 
эскиз. 

 Указание операции (создать – сплошное тело, вырез, поверхность и тд). 
 Установка угла и направления поворота. 
 Завершение создания объекта. 

 Панель редактирования вращения мало, чем отличается от панели редактирования выдавливания. В ней 
присутствуют те же инструменты для создания операции (рис. 2.8). Естественно размеры здесь представлены в 
градусах, а не в миллиметрах. 

 
Рисунок 2.8 - Панель редактирования вращения 

Если не возникает никаких проблем, то операция отображается в виде желтого элемента, который приобретает 
характерный цвет по окончании операции (рис. 16). 

 
Рисунок 2.9 – Операция вращения 

Если создается вращение на определенный угол, то этот угол можно указать интерактивно: зажав белый 
квадратик левой кнопкой и протащив его на определенный угол или же сделав двойной щелчок на размере, указав в 
появившемся окне размер. 

 

2.1.3.2   Создание безэскизных фитчеров 
 

В Pro/ENGINEER Wildfire существует много различных способов создания геометрических объектов. Можно 
использовать традиционные подходы, начинающиеся с двухмерного эскизирования, затем, переходящие в 
твердотельные объекты, с необходимостью их образмеривания и размещения. В качестве альтернативы, можно 
использовать безэскизные фичеры для быстрого создания таких объектов, как отверстия, фаски и скругления, 
размещая эти предопределенные формы на уже существующие объекты. Этот способ упрощает процесс создания 
объектов. Пропускается стадия эскизирования и можно заняться непосредственным размещением и образмериванием 
данных объектов на модели.  

Безэскизные фичеры (такие как отверстия и скругления) позволяют быстро размещать необходимый элемент на 
модели выбором определенной геометрии. Например, можно поместить отверстие на поверхность, или поместить 
скругление на кромку. Для Pro/ENGINEER форма этих объектов является предопределенной, соответственно не 
требующей создания эскиза. Далее, можно определить размеры объекта и установить для него ссылки на размещение. 
Окончательную доработку создаваемых фичеров можно производить с помощью маркеров (белые квадратики, 
появляющиеся на предварительном просмотре создаваемого фичера). С помощью маркеров будет изменяться 
внешний вид динамического просмотра создаваемого фичера. Например, можно воспользоваться маркерами для 
изменения диаметра создаваемого отверстия, местоположения отверстия на  модели, радиуса скругления и тд. 
Помимо маркеров, доступны контекстные меню, всплывающие по правой клавише мыши. Например, если навести 
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курсор на маркер глубины и нажать на правую клавишу мыши, то будут доступны дополнительные опции задания 
глубины (Через все, До следующей и тд). Все опции, отображенные на экране можно также устанавливать с помощью 
диалоговой панели инструментов, отображенной внизу экрана. 

Операция Hole (Создание отверстий) 
Для создания простых отверстий, отверстий отвечающих требованиям ГОСТа, а также отверстий имеющих 

стандартную резьбу вовсе не обязательно пользоваться командами выдавливания или вращения, создавая при этом 
эскиз. Для создания отверстия на панели инструментов выбирается иконка  (Hole Tool). При создании отверстия,  
его местоположение на модели определяется с помощью первичных и вторичных ссылок. Сегмент геометрии, 
который будет первым выбран для размещения отверстия, и будет первичной ссылкой. Затем выбираются вторичные 
ссылки, с помощью которых образмеривается отверстие на модели.  Тип геометрии (плоская поверхность, 
цилиндрическая поверхность, ось или точка), выбранная в качестве первичной ссылки, продиктует тип создаваемого 
отверстия. После выбора пригодных для использования ссылок, система покажет динамический предварительный 
просмотр создаваемого отверстия с заданными по умолчанию значениями диаметра и глубины. Эти значения можно 
изменить с помощью маркеров, либо с помощью диалоговой панели создания отверстия. 

 Linear Hole (Линейное Отверстие) 
Плоская поверхность выбрана в качестве первичной ссылки. Эта поверхность определяет, откуда будет 

произведено «сверление». Две вторичные ссылки будут определять базы, относительно которых будет определятся 
местоположение отверстия. На рисунке 2.10 показана модель с линейным отверстием. Верхняя поверхность модели 
является первичной ссылкой, а боковые поверхности, вторичными ссылками. 

Как видно из рисунка, на отображении отверстия 
присутствуют пять белых квадратов (маркеров), которые 
являются концевыми точками размеров определяющих 
положение отверстия в пространстве и его глубину. Для создания 
отверстия необходимо указать диаметр, глубину отверстия и 
положение центра отверстия в выбранной плоскости. Эти 
размеры задаются интерактивно (непосредственно в поле 
модели) или при помощи панели редактирования отверстия (рис. 
2.11). Если хотя бы один размер, определяющий положение 
центра отверстия на плоскости не задан, завершение операции не 
возможно (кнопка  не активна). 

В меню Placement указывается плоскость, с 
которой начинается выдавливание отверстия и две 
базовые поверхности относительно которых 
располагается центр отверстия. В меню Shape 
указываются параметры отверстия: диаметр, способ 
выдавливания (способы выдавливания аналогичны операции выдавливания). Под меню располагаются иконки и окна. 
Самая левая иконка – создание простого отверстия, правее – создание стандартного отверстия. От выбора одной из 
этих иконок зависит вид панели редактирования. В данном случае создается простое отверстие, поэтому на рисунке 
показан данный вид панели. Правее расположено окно для указания диаметра и способ выдавливания. 

 Coaxial Hole (Соосное Отверстие) 
Ось выбрана в качестве первичной ссылки. Эта ось определяет местоположение отверстия в модели. Для 

завершения создания отверстия, нужно указать вторичную ссылку. Это должна быть поверхность, от которой система 
начнет «сверление». 

 Radial Hole (Радиальное Отверстие) на плоской поверхности 
В качестве первичной ссылки выбирается плоская поверхность. Эта поверхность определяет, откуда будет 

произведено «сверление». В качестве вторичной ссылки будет выступать ось, определяющая центр радиуса 
расположения отверстия и плоскость, от которой будет отложен угловой размер. 

 Radial Hole (Радиальное Отверстие) на цилиндрической поверхности 
В качестве первичной ссылки выбирается цилиндрическая поверхность. В качестве вторичной ссылки будет 

выступать плоская поверхность, определяющая положение центра отверстия, и плоскость, от которой будет отложен 
угловой размер [13]. 

Операции Round, Chamfer (Создание скругления и фаски) 
Скругление – это добавление или удаление материала, созданием гладких переходов между поверхностями. 

При создании скругления, Pro/ENGINEER ожидает выбора кромок и/или поверхностей, чтобы использовать их в 
качестве ссылок. Комбинация из выбранных ссылок определяет тип создаваемого скругления. Существует четыре 
типа скругления, из названия которых становиться понятно, какие ссылки необходимо указывать при их создании. 

 Edge Round (Скругление кромок). Скругление кромок потребует выбора кромки (или кромок). Кромки 
могут быть выбраны индивидуально, или с использованием различных способов выбора целых цепочек кромок. 

 
Рисунок 2.10 – Создание отверстия 

 
Рисунок 2.11 – Панель редактирования отверстия 
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При создании скругления, оно автоматически распространиться на всю цепочку касательных кромок. 
Поверхность скругления будет касательна к поверхностям, пересечение которых образовало скругляемую кромку. 

 Surface – Edge Round (Скругление Кромки и Поверхности). Скругление кромки и поверхности 
потребует выбор поверхности и кромки. Скругление будет построено касательно к указанной поверхности, 
проходящим через указанную кромку. Если выбранная кромка будет частью касательной цепочки кромок, 
скругление распространится на всю цепочку. 

 Full Round (Полное Скругление). Полное скругление заменяет поверхность поверхностью скругления с 
соответствующим радиусом. Создание полного скругления потребует выбора пары кромок или пары 
поверхностей. Если выбрать пару кромок, система вначале создаст скругление каждой кромки, которое можно 
легко конвертировать в полное скругление. Если выбрана пара поверхностей, придется дополнительно выбрать 
поверхность, которая будет заменена поверхностью скругления. Если выбранная геометрия имеет касательные 
элементы, система построит это скругление по всем касательным элементам. 

 Surface – Surface Round (Скругление Поверхность к Поверхности). Создание скругления поверхность к 
поверхности потребует выбора двух поверхностей. Поверхность будет построена касательно к указанным 
поверхностям. Если выбранная геометрия имеет касательные элементы, система построит это скругление по всем 
касательным элементам. Скругление Поверхность к Поверхности создает поверхность скругления между 
указанными поверхностями, следовательно, у системы есть возможность охватывать промежутки и дыры в 
существующей геометрии. Дополнительно такой тип скругления обеспечивает более корректную геометрию 
скругления, там, где другие типы скругления не применимы. 
После того, как ссылки выбраны, система покажет на модели предварительный просмотр создаваемого 

скругления с заданным по умолчанию радиусом. Можно установить собственное значение радиуса с помощью 
маркеров или с помощью диалоговой панели создания скругления. 

Фичер скругления может содержать несколько наборов ссылок. Например, при выборе кромок для скругления, 
они могут быть выбраны в одном наборе или в разных наборах. Если выбрать кромки в разных наборах, каждый набор 
будет иметь свой собственный радиус, также, благодаря разным наборам, в одном фичере скругления может быть 
несколько типов скругления. 

Создание фасок. Подобно радиусам, с помощью фасок можно также добавлять или удалять материал, создавая 
скошенную поверхность между двумя смежными поверхностями. В качестве ссылки при этом может выступать 
кромка, кромка и поверхность, поверхность и поверхность. При создании фаски устанавливается ее местоположение 
на модели, определяется ее размерная схема и вводится соответствующие значения размеров. 

Размерные типы фасок: 45 x D, D x D, D1 x D2, ANG x D [13]. 
Так же как и для скруглений, фитчер Фаска может 

содержать несколько наборов ссылок. Соответственно, каждый 
набор может быть со своей размерной схемой и со своими 
значениями размеров. При использовании нескольких наборов, 
есть возможность устанавливать типы переходов в тех местах, 
где эти наборы пересекаются. 

Для создания операции скругления или фаски необходимо 

на панели инструментов выбрать Round Tool ( ) или Chamfer 

Tool ( ) соответственно. Затем указывается грань и размер 
сругления или фаски (рис. 2.12). 

При выборе грани система автоматически устанавливает 
размер, который легко корректируется в пространстве модели 
или при помощи панели редактирования (рис. 2.13). 

 
Рисунок 2.13 – Панель редактирования скругления 

Операция Draft (Создание уклонов) 
В данном программном продукте создание уклона представлено как отдельная операция, в отличие от других 

программных продуктов (Компас, Cimatron) в которых данная операция представлена совместно с операцией 
выдавливания. Уклоны (Drafts) обычно используются при проектировании деталей, получаемых литьем, и деталей 
литейных форм. Существует несколько типов уклонов, которые устанавливаются в зависимости от выбранных ссылок 
(кривых, поверхностей, опорных плоскостей). Уклоном можно добавлять или удалять материал. Диапазон уклона +/-
30°.Ниже приведена терминология, используемая при создании уклонов. 

 Draft surfaces (Поверхности уклона). Поверхности модели, выбранные для задания уклона. 
 Draft hinges (Нейтральные элементы уклона). Кривая на поверхностях уклона (нейтральная), которая 
используется как ось поворота поверхностей уклона. Нейтральный элемент уклона может быть определен 
выбором плоскости, а линия пересечения этой плоскости с поверхностью уклона и будет осью уклона. 

 Pull direction (Направление нормали). Направление (направление уклона), которое используется для 
измерения угла уклона. Обычно направление нормали показывает направление разъема пресс-формы. Можно 
определить это направление выбором плоскости (тогда направление нормали будет перпендикулярно этой 
плоскости), линейной грани, опорной оси или осей системы координат. 

 
Рисунок 2.12 – Создание скругления 
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 Draft angle (Угол уклона) - Угол между направлением уклона и уже наклоненными поверхностями 
уклона. Если поверхности уклона разделены, можно задать два независимых угла для каждой части уклона [13].  
При создании уклона необходимо выбрать поверхность для уклона, это будет первичной ссылкой. В качестве 

вторичной ссылки выбирается нейтральный элемент уклона, относительно которого система будет наклонять 
поверхность. По умолчанию, система создает уклон без излома. Однако излом может быть добавлен как по 
нейтральному элементу, так и по специально указанному элементу излома (плоскость или эскизная кривая). 

 Для создания уклона необходимо нажать  (Draft Tool). Панель редактирования имеет вид (рис. 2.14): 

 
Рисунок 2.14- Панель редактирования 

Для создания уклона необходимо выделить поверхность, которая будет подвергнута данной операции, затем 
выбрать нижнее окошко в панели редактировании и указать поверхность относительно которой будет создаваться 
уклон. После этого и в панели и в пространстве модели появляется возможность указать направление и величину 
уклона (рис. 2.15). 

 
Рисунок 2.15 – Создание уклона 

Операция Pattern 
Часто в детали присутствуют одинаковые элементы, которые можно создать при помощи массива (массив по 

сетке, по окружности, по прямой и т.д.). Было бы не рационально создавать каждый из этих элементов по 
отдельности, для этого служит операция Pattern. Для создания массива необходимо на панели инструментов выбрать 

 (Pattern Tool). В панели редактирования (рис. 2.16) необходимо выбрать способ создания массива. 

 
Рисунок 2.16 – Панель редактирования массива 

Это делается при помощи окна расположенного в левом нижнем углу. Допустим, необходимо создать 
несколько одинаковых элементов расположенных на одной линии (рис. 2.17). 

 
Рисунок 2.17 – Создание массива 

Для этого нужно указать элемент, который необходимо «скопировать» (это можно сделать до создания 
операции, выделив его). После указывается способ создания массива, например для кругового массива нужно выбрать 
Axis и указать ось вращения. В данном случае выбирается Direction, затем выбирается плоскость, относительно корой 
будет проставляться размер. Количество копий, расстояние между ними, направление выбирается в панели 
редактирования или интерактивно. При этом создаваемые объекты на данной стадии будут отображены в виде 
крупных черных точек. Не стоит забывать, что элемент являющийся исходным для данной операции тоже входит в 
число копий. 

2.1.3.3   Использование вспомогательной геометрии 
 

Часто для создания элемента необходимо наличие опорной плоскости, отстоящей от какой-либо поверхности 
на расстоянии и ли повернутой на определенный угол. Для создания таких плоскостей служит инструмент  (Datum 
Plane Tool). При нажатии этой иконки появляется окно Datum Plane (рис. 2.18): 
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Наиболее важной в этом окне является первая закладка. 
Здесь указывается способ создания плоскости (касанием, на 
расстоянии, параллельно, перпендикулярно). Но эта закладка 
активизируется лишь после того, как будет указан объект, 
относительно которого будет создана плоскость. В роли объекта 
выступает плоскость или плоская поверхность. Как только объект 
выделен, в окне References появляется его имя и способ 
получения новой плоскости. Изначально система предоставляет 
произвольный способ получения плоскости, чтобы его изменить 
необходимо щелкнуть на нем мышкой, появится галочка, нажав 
на которую можно выбрать необходимый способ. Следует 
заметить, что при выборе одной плоскости не доступно получение 
плоскости повернутой на определенный угол. Для ее получения 
необходимо указать еще один элемент, например грань, которая 
будет осью поворота. Для одновременного указания нескольких 

объектов следует зажать Ctrl. Только после этого в окне References появится новый пункт Through (рис. 2.19) и можно 
указать угол. 

На рисунке розовым цветом 
выделена плоскость, относительно которой 
производится поворот, толстой красной 
линией ось (грань) поворота. 

Пять ограничений, с помощью 
которых можно зафиксировать плоскость в 
пространстве: 

 Thorough (Через). Плоскость 
пройдет через указанную 
кромку, вершину, ось или 
точку. 

 Offset (Смещение). 
Плоскость будет построена 
на расстоянии от уже 
существующей плоскости 
или плоской поверхности. 

 Parallel (Параллельно). 
Плоскость будет параллельна указанной опорной плоскости или плоской поверхности. 

 Normal (Нормально). Плоскость будет перпендикулярна указанной оси, поверхности или опорной 
плоскости. 

 Tangent (Касательно). Плоскость будет касательна к указанной кромке или поверхности. 
Опорная плоскость по своему определению бесконечна, однако можно установить ее визуальное отображение, 

подогнав его по детали, фичеру, поверхности, кромке или радиусу. 
Таким образом, используя эти не хитрые инструменты можно создавать практически любые детали (рис. 2.20). 

 
Рисунок 2.20 - Деталь 

 

 
Рисунок 2.18 – Окно редактирования плоскости 

 
Рисунок 2.19 – Создание плоскости под углом к данной 
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2.2   Использование операции вычитания для создания матрицы и пуансона  
 
Для создания матрицы и пуансона необходимо иметь готовую деталь или поверхности, которые будут 

участвовать в создании новой детали. При наличии детали производится операция вычитания геометрии одной детали 
из другой. Обычно данная операция присутствует при создании сборки, но в Pro/Engineer Wildfire 2.0 эта операция 
выполняется при создании детали. 

Сначала создаются контуры матрицы и пуансона (рис. 2.21), затем производится операция вычитания, а после 
стандартными операциями выдавливания вращения и т.д. форма детали доводится до логического конца. 

 
Рисунок 2.21 – Начальный вид матрицы 

Чертежи матрицы и пуансона представлены на рисунках 2.22, 2.23 

 
Рисунок 2.22 – Чертеж матрицы 
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Для создания операции вычитания необходимо выполнить: Insert>Shared Data>Cutout from Other Model. 
Появятся два окна (рис. 2.24): 

В окне Menu Manager выбираем строку Open и, в появившемся окне, выбираем 
файл детали, геометрию которой необходимо вычесть. В отдельном окне откроется 
деталь (рис. 2.25), которую необходимо расположить относительно создаваемой по все 
правилам сборки, то есть деталь должна быть «неподвижной». 

 
Рисунок 2.25 – Расположение детали относительно создаваемой 

матрицы 

При этом сборка деталей не отображается, что несколько затрудняет работу, но, нажав на кнопку , 
можно увидеть расположение деталей (вычитаемая модель будет отображаться в виде каркаса). После этого нажимаем 
кнопку ОК в окне External Cut out, операция вычитания произведена (рис. 2.26). 

После доработки матрицы при помощи стандартных 
операций, она приобретает окончательную форму (рис. 2.27): 

 
Рисунок 2.27 - Матрица 

Аналогичным образом создается пуансон (рис. 2.28): 

 
Рисунок 2.28 - Пуансон 

 
Рисунок 2.24 – Операция 

вычитания 

 
Рисунок 2.26 – Результат вычитания 
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2.3   Создание сборки в Pro/Engineer Wildfire 2.0 
 
Как и в большинстве иностранных продуктов, сопряжение компонентов в Pro/Engineer Wildfire 2.0 

производится с использованием жестких привязок. Жесткими привязки называются потому, что при их применении, 
сопрягаемый компонент лишается всех своих степеней свободы и жестко фиксируется в сборке. Существуют и так 
называемые «мягкие» привязки, обозначаемые термином Connections (Соединения). Соединения сопрягают деталь в 
сборке с сохранением одной, двух и более степеней свободы, и используются при создании механически подвижных 
соединений. 

Для создания новой сборки необходимо выбрать иконку New, в появившемся окне указать тип создаваемого 
файла – Assembly (Сборка), а так же название (рис. 2.29). 

 Сборка осуществляется добавлением новых компонентов или 
созданием этих компонентов в контексте сборки. Для того чтобы добавить 
новый компонент необходимо выбрать Add component to the assembly 

( ), для создания нового компонента нужно выбрать Create a component 

in assembly mode ( ). При выборе добавления компонента сборки 
открывается окно Open, в котором предлагается открыть файл добавляемой 
детали. После того как деталь выбрана, открывается окно Component 
Placement (Размещение компонента) (рис. 2.30): 

Сначала в этом окне присутствует 
только одна привязка – Automatic, то есть 
компонент сборки размещается 
автоматически. В принципе, если нет 
никаких ограничений, первый компонент 

сборки можно разместить автоматически (рис. 2.31): 
Но для того чтобы 

зафиксировать компонент 
необходимо нажать кнопку Fix 

component ( ), или установить 
компонент по умолчанию, нажав 
Assemble component at default 

location ( ). После этого 
компонент сборки размещается в 
поле сборки и отображается в дереве построения. При этом если 
компонент не лишен всех степеней подвижности, то его запись в 
дереве построения имеет вид: . Наличие 
прямоугольника перед названием компонента свидетельствует о 
том, что компонент не зафиксирован и наоборот отсутствие 
этого прямоугольника свидетельствует о фиксации компонента: 

. После того как первый компонент установлен, 
можно добавлять или создавать оставшиеся компоненты сборки. 

Все последующие компоненты сборки сопрягаются при помощи следующих привязок: Automatic (Автоматически), 
Mate (Наложение), Align (Совмещение), Insert (Вставить), Coordinate System (Координатная система), Default (По 
умолчанию), Fix (Зафиксировать). 

Основные правила использования привязок: 
 При использовании привязок Mate (Наложение) и Align (Совмещение), обе ссылки должны быть 
одного и того же типа (например, плоскость к плоскости, поверхность вращения к поверхности вращения, точка к 
точке, ось к оси). 

 При использовании привязок Mate (Наложение) и Align (Совмещение) и введении величины смещения, 
система показывает направление смещение. Если нужно поменять направление на обратное, необходимо 
щелкнуть Change Orientation (Изменить ориентацию модели). 

 Система добавляет привязки по одной. Например, не возможно использовать единственную привязку 
Align Совмещение) для совмещения двух отверстий в одной детали с двумя отверстиями в другой. В этом случае, 
придется использовать две различные привязки Align (Совмещение). 

 Для полного размещения компонента в сборке, придется воспользоваться комбинацией из привязок. 
Например, можено сопрячь пару поверхностей с помощью привязки Mate (Наложение), вторую пару 
цилиндрических поверхностей, с помощью привязки Insert (Вставить), а третью пару инструментом Align 
(Совмещение) использовать для ориентации. 

 Совмещение под углом двух поверхностей, возможно только после совмещения двух осей или 
линейных кромок [14]. 

Mate (Наложение) 
Данная привязка использует для позиционирования две плоские поверхности или опорные плоскости, которые 

накладываются друг на друга, можно использовать также и конические поверхности. В этом случае за один шаг 

 
Рисунок 2.29 – Создание новой сборки 

 
Рисунок 2.30 – Окно 

размещение компонента 

 
Рисунок 2.31 – Добавление первого компонента 
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накладываются  поверхности, и задается их соосность. Опорные плоскости имеют Главную и Вспомогательную 
стороны. Коричневая сторона - Главная, серая сторона - Вспомогательная. При использовании привязки Mate 
(Наложение) по отношению к плоскостям, система накладывает плоскости друг на друга именно коричневыми 
сторонами. 

 Если при наложении, необходимо установить между плоскостями зазор, нужно ввести величину зазора, при 
этом система стрелкой покажет направление, в котором  откладывается размер. Значение размера может быть как 
положительным, так и отрицательным. Это определит направление откладывания размера. Направление также можно 

поменять иконкой Change Orientation  (Изменить ориентацию модели). Если ввести ноль, плоскости будут 
наложены друг на друга без зазора. 

Типы смещения привязки Mate: 
 Offset (Смещение). Позволяет определить зазор между накладываемыми плоскостями (плоскими 
поверхностями). 

 Oriented (Ориентировать). Разворачивает выбранную плоскость «лицом» к другой плоскости без 
определения величины смещения. При необходимости, можно поменять направление взгляда на обратное. 

 Coincident (Совпадение). То же самое, что и наложение с нулевым зазором, только здесь не требуется 
задание размера. 

 Angle Offset (Угол наложения) – Позволяет повернуть одну поверхность по отношению к другой, на 
определенный угол [14]. 

Align (Совмещение) 
Используется для позиционирования двух плоскостей или плоских поверхностей, которые система 

совмещаются заподлицо. Могут также использоваться две опорные оси или линейные кромки, которые будут 
расположены соосно. Могут также использоваться две опорные точки, которые будут совмещены. При совмещении 
опорных плоскостей, их коричневые стороны будут смотреть в одном направлении (в противоположность привязки 
Mate (Наложение)). При задании смещения, система стрелкой покажет положительное направление откладывания 
размера. Его можете поменять иконкой Change Orientation (Изменить ориентацию модели). Если ввести ноль, 
плоскости будут совмещены друг с другом без зазора. 

Типы смещения привязки Align: 
 Offset (Смещение). Позволяет определить зазор между совмещаемыми плоскостями (плоскими 
поверхностями). 

 Oriented (Ориентировать). Устанавливает направление взгляда выбранной плоскости таким же, как и у 
ссылочной плоскости без определения величины смещения. 

 Coincident (Совпадение). То же самое, что и совмещение с нулевым зазором, только здесь не требуется 
создание размера. 

 Angle Offset (Угол наложения) – Позволяет повернуть одну поверхность по отношению к другой, на 
определенный угол. 
Привязки Mate и Align являются взаимозаменяемыми, это значит, что в любое время можно поменять Mate 
на Align и наоборот, без необходимости повторного выбора ссылок [14]. 

Insert (Вставить) 
Используется для позиционирования двух поверхностей вращения, которые располагаются соосно. 

Поверхности могут быть цилиндрическими и коническими. Эта ссылка полезна в тех случаях, когда выбор осей 
невозможен или затруднителен. Привязка Insert это жесткая привязка, и она не обеспечивает возможности 
перемещения детали в осевом направлении, даже если других привязок не будет [14]. 

Coordinate System (Координатная система) 
Используется для размещения компонента в сборке совмещением системы координат этого компонента с 

другой системой координат в сборке. Можно использовать системы координат, созданные на уровне детали, и 
сборочные системы координат. Можно выбирать системы координат непосредственно в графическом окне или 
воспользоваться инструментом поиска. При совмещении систем координат, Pro/ENGINEER совмещает 
соответствующие оси сопрягаемых систем, т.е. ось Х одной системы накладывается на ось Х другой в том же 
направлении, это же относиться к осям Y и Z. Привязка Coordinate System (Координатная система) обеспечивает 
полное определение компонента в сборке, соответственно является единственной привязкой при сопряжении деталей. 

Default (По умолчанию) 
Используется для размещения компонента в сборке, совмещением его созданной по умолчанию системы 

координат с созданной по умолчанию системой координат сборки. При использовании этой привязки, не требуется 
указывать какие системы координат необходимо совмещать. Система это знает и так. Это стандартная практика при 
размещении в сборке первого компонента [14]. 

Fix (Зафиксировать) 
Используется для фиксации (замораживания) компонента в текущем положении. Эта привязка может быть 

использована в следующих случаях: 
 Зафиксировать компонент после наложения основных привязок, если они обеспечивают лишь 
частичное определение компонента. 

 Зафиксировать компонент после его свободного позиционирования в 3D. 
 Временно зафиксировать компонент в пространстве, если ссылок для его размещения в сборке пока нет 

[14]. 
На рисунке 2.32 показан процесс сопряжения матрицы с корпусом при помощи стандартных привязок. 

ДП Дм. Шарагина Рук-ль доц. Калачев О.Н. 2006 Каф. ТМС ЯГТУ с Web-страницы http://tms.ystu.ru



 71

 
Рисунок 2.32 – Сопряжение корпуса и матрицы 

При сопряжении этих двух компонентов были использованы привязки Align и Mate. 
При сопряжении корпуса и пунсона сначала используем привязку Insert для конической поверхности (рис. 2.33) 

 
Рисунок 2.33 – Сопряжение корпуса и пунсона 

После этого пуансон имеет две степени свободы: вращение и перемещение относительно оси конического 
отверстия. После этого наложим такое же ограничение на цилиндрическую поверхность (рис. 2.34). 

 
Рисунок 2.34 – Наложение привязки Insert 

Красными эллипсами показаны поверхности, на которые наложено ограничение соосности. Последний шаг – 
лишение возможности перемещения пуансона вдоль осей соостных поверхностей (рис. 2.35). 
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Рисунок 2.35 – Сопряжение пуансона и корпуса 

Осуществляем сопряжение подвижной матрицы и пуансона (рис. 2.36). 

 
Рисунок 2.36 – Сопряжение пуансона и подвижной матрицы 

В результате получим сборку детали, неподвижной матрицы, пуансона, подвижной матрицы (рис. 2.37). 

 
Рисунок 2.37 - Сборка 
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2.4   Проектирование NC обработки в Pro/Engineer Wildfire 2.0 
 
Дерево проекта имеет вид (рис. 2.38): 

М    о    д    е    л    ь    и    з    д    е    л    и    я    З    а    г    о    т    о    в    к    а    

М    о    д    е    л    ь    о    б    р    а    б    о    т    к    и    Н    а    с    т    р    о    й    к    а    п    р    и    с    п    о    с    о    б    л    е    н    и    й    С    т    а    н    о    к    

И    н    с    т    р    у    м    е    н    т    ы    Н    а    с    т    р    о    й    к    а    б    а    з    ы    д    а    н    н    ы    х    
о    б    р    а    б    о    т    к    и    

Н    а    с    т    р    о    й    к    а    о    п    е    р    а    ц    и    и    

С    о    з    д    а    н    и    е    т    р    а    е    к    т    о    р    и    и    
о    б    р    а    б    о    т    к    и    

С    о    з    д    а    н    и    е    ф    а    й    л    о    в    
с    д    а    н    н    ы    м    и    C    L    D    a    t    a    

П    о    с    т    п    р    о    ц    е    с    с    о    р    

У    п    р    а    в    л    я    ю    щ    а    я    п    р    о    г    р    а    м    м    а    

П    о    л    у    ч    е    н    и    е    п    р    о    м    е    ж    у    т    о    ч    н    ы   х  
м    о    д    е    л    е    й    о    б    р    а    б    о    т    к    и    

 
Рисунок 2.38 – Дерево проекта 

 
Начинаем работу с создания нового проекта. Для того чтобы войти в модуль NC, нажимаем New, выбираем тип 

Manufacturing и подтип NC Assembly (рис. 2.39). 
В этом же окне указывается имя файла, в который впоследствии будет 

сохранена обработка. Файл имеет расширение .mfg, но помимо этого файла 
создается еще множество дополнительных файлов, участвующих в создании 
NC обработки. Например, если создается заготовка, то она записывается в файл 
с расширением .prt. Для ориентации заготовки относительно детали создается 
файл сборки с расширением .asm, при создании траектории так же создается 
новый файл, не говоря уже о бесчисленном множестве файлов trial.txt, которые 
плодятся как саранча, но при этом не несут в себе полезной информационной 
нагрузки. 

После того как будут выбраны тип, подтип и имя нового проекта можно 
нажать кнопку ОК. Открывается стандартное окно Pro/ENGINEER, в правой 
верхней части расположено окно Menu Manager, которое будет присутствовать 
на всех стадиях создания NC-обработки (рис. 2.40).  

Рисунок 2.39 – Запуск модуля NC 
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При выборе каждого из пунктов этого окна появляются новые окна 
схожие с данным, при этом они располагаются непосредственно под 
предыдущим окном, которое в этот момент сворачивается в строчку. Работа 
начинается, так же как и в других программах с размещения готовой или 
создания новой детали. Для этого выбирается пункт Mfg Model, это 
сопровождается открытием нового окна, в котором предоставляется выбор 
добавить готовую модель или создать ее. Выбираем Assemble, появляется 
новое окно с пунктами Ref Model, Workpiese (рис. 2.41). 

 Выбираем первый 
пункт. Открывается окно 
Open, в нем указываем 
деталь, подлежащую 
обработке. Появляется окно 
размещения детали 
(аналогичное окну 
размещения детали в сборке). 
Деталь размещаем с 
использованием привязки 
«по умолчанию», при 

помощи иконки  (рис. 
2.42). 

Следующий шаг – это создание заготовки. 
В окне Mfg Model выбираем пункт Create> 
Workpiese, в командной строке вводится имя 
файла, который будет содержать заготовку (рис. 
2.43).  

В 
окне Menu 

Manager 
предлагае
тся указать тип заготовки Solid, Surface и т.д. (рис. 2.44). 

 По умолчанию открывается первый 
пункт. Выбираем пункт Protrusion. 
Появится окно позволяющее выбрать 
операцию, при помощи которой будет 
создана заготовка (рис. 2.45). По 
умолчанию этой операцией является 
операция Extrude (Выдавливание), 
нажимаем Done. 

 
Рисунок 2.40 – Окно Menu Manager 

 
Рисунок 2.41 – Выбор модели для обработки 

 
Рисунок 2.42 – Вставка обрабатываемой модели в NC-обработку 

 
Рисунок 2.43 – Создание файла 

заготовки 

 
Рисунок 2.44 – Выбор типа создаваемой заготовки 
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Выбираем иконку эскиза, в появившемся окне 
интерактивно указываем плоскость эскизирования, в графе 
References укажем одну из основных плоскостей 
перпендикулярную плоскости эскизирования. После этого 
станет доступной кнопка Sketch, нажав на которую можно 
приступить к созданию эскиза. Создаем эскиз 
прямоугольника (рис. 2.46). При этом все это время мы 
находимся внутри операции выдавливания, которая 
временно «заморожена». 

После того как эскиз создан, можно выйти из него, 
нажав галочку. Теперь необходимо обратить взгляд к нижней 
части экрана, где отображена операция выдавливания. 

Нажимаем кнопку  для возобновления операции 
выдавливания, указываем созданный эскиз, задаем параметры 

заготовки, нажимаем . При этом заготовка приобретает 
зеленый цвет и становится прозрачной (рис. 2.47). 

После того как деталь и заготовка созданы, их наличие 
в обработке отображает дерево построения (рис .2.48) 

После создания рабочей зоны (заготовки) можно 

перейти к 
следующему 
шагу – 
Manufacturing 
Setup. Для 

этого 
закрываем 

окно Mfg 
Model, нажав 

Done/Rturn. 
После этого в 
окне Menu 

Manager 
выбирается пункт Mfg Setup, открывается окно 
Operation Setup (рис. 2.49).  

В окне можно увидеть множество различных 
пунктов, обязательных к заполнению. Некоторые 
пункты доступны к заполнению только на данной 
стадии, другие можно заполнить или 

откорректировать позже. В верхней части окна 
расположены строки «Наименование операции» 
(Operation Name) и «Параметры станка» (NC Machine). 
Первый пункт предполагает наличие названия операции, 
по умолчанию название указано автоматически в виде 
кода, при желании его можно изменить. Выбираем пункт 

NC Machine, нажав , открывается окно Machine Tool 
Setup (рис. 2.50). 

 
Рисунок 2.45 – Выбор операции для создания заготовки 

 
Рисунок 2.46 – Эскиз заготовки 

 
Рисунок 2.47 – Заготовка для NC-обработки 

 
Рисунок 2.48 – Дерево построения 

 
Рисунок 2.49 – Окно Operation Setup 
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В этом окне можно выбрать наименование, 
тип обработки (Mill, Lathe, Mill/Turn, Wedm), 
вид обработки (трех-, четырех- или 
пятикоординатная), опции постпроцессора и др. 
Следующая закладка в данном окне – Spindle, 
здесь можно указать максимальную скорость 
инструмента. В основной части окна выбираем 
Mill, 3 Axis. Закладка Cutting Tools позволяет 
выбрать инструмент на данную операцию для 

этого необходимо нажать кнопку . 
После этого появится окно выбора 

инструмента (рис. 2.51). 

В этом окне можно указать наименование инструмента, тип 
инструмента, материал, основные размеры инструмента, систему 
измерения (для установки метрической системы в графе Units 
выставляем значение Millimeter). После выбора основных параметров 
нажимаем Apply, и инструмент добавляется в таблицу, 
расположенную в верхней части данного окна. Для выхода из окна 
инструмента нажимаем OK, и возвращаемся в окно Machine Tool 
Setup из которого выходим, нажав ОК. 

В закладке General окна Operation Setup необходимо установить 
«машинный ноль» (Machine Zero) для этого нажимаем кнопку в виде 
стрелочки. В Menu Manager выбираем Create, указываем рабочую зону 
(заготовку), появляется окно, предлагающее расположить 
координатную систему. Интерактивно указываем место расположения 
системы координат. Расположи ее в верхнем левом углу заготовки. 
Для этого выделим соответствующие ребра заготовки левой кнопкой мыши с зажатым Ctrl. После этого в графе 
References закладки Origin отобразятся выделенные объекты (рис. 2.52).  

После размещения системы координат необходимо ее 
сориентировать. Это осуществляется при помощи второй закладки. 
Ориентирование системы координат производится по двум осям при 
помощи кнопки Flip (рис. 2.53). Ось Z должна быть направлена в ту 
сторону, откуда опускается инструмент (это справедливо для 
трехкоординатной обработки). 

Нажима
ем ОК в окне 

Operation 
Setup. 

Результаты 
отображаются 
в дереве 
построения 

(рис. 2.54).  
На рисунке 

отображено 
создание 

«Машинных 
параметров» 

(MACH01), новой 
операции 

(OP010[MACH01]). 
При желании эти 
параметры можно 
изменить. Для этого нужно в дереве каталогов выбрать необходимый пункт и в 
контекстном меню выбрать Edit Definition. 

Следующий шаг – создание зоны обработки. Зона обработки 

 
Рисунок 2.50 - Окно Machine Tool Setup 

 
Рисунок 2.51 – Окно выбора инструмента 

 
Рисунок 2.52 – Создание точки 

«машинный ноль» 

 
Рисунок  2.53 – Ориентация созданной СК 

 
Рисунок 2.54 – Дерево построения 
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представляет собой твердое тело, полученное при помощи стандартных операций, таких как выдавливание, вращение 
и т.д. Для этого в окне Menu Manager выбираем Mfg Setup>Mfg Geometry>Mill Volume>Create, в командной строке 
вводим имя v1. Переходим в Menu Manager, вбираем Sktch>Dune> Dune. Первой командой Dune подтверждается 
создание твердого тела операцией выдавливания, второй указывается направление выдавливания – в одну сторону 
(рис. 2.55). 

Выбираем плоскость расположения эскиза (рис. 2.56). 

 
Рисунок 2.56 – Выбор плоскости эскиза для создания рабочей зоны 

Нажимаем Okey>Bottom, выбираем плоскость перпендикулярную выбранной ранее, после чего переходим в 

режим эскизирования. В эскизе выбираем кнопку  (построение элемента по ребру) и поочередно выбираем грани 
рабочей зоны (четыре грани). Нажимаем Close в окошке Type, подтверждая выбор типа Single (рис. 2.57), выходим из 
эскиза. Если в выбираемом контуре присутствует слишком много граней можно выбрать другой тип, например Chain. 

 
Рисунок 2.57 – Создание эскиза зоны обработки 

В окне Menu Manager выбираем Blind>Done. В командной строке вводим расстояние, на которое выдавливается 
эскиз (рис. 2.58).  

 
Рисунок 2.58 – Использование операции выдавливания для создания зоны обработки 

В окне создание операции выдавливания нажимаем ОК. После этого возвращаемся в окно Menu Manager. 
Создаем вторую зону обработки по вышеизложенным принципам, но с некоторыми отличиями. В окне Mill Volume 
выбираем Create, в командной строке вводим имя новой зоны обработки (v2) после чего в окне Menu Manager 
выбираем Sktch>Dune> Dune. В качестве плоскости для эскиза выбираем нижнюю поверхность только что созданной 
зоны обработки (названой v1). Нажимаем Okey>Bottom, выбираем плоскость перпендикулярную выбранной ранее и 

автоматически переходим в среду создания эскиза. В эскизе используем кнопку  (Create an entity by offsetting an 
edge) создание элемента со смещением от ребра. Для создания эквидистанты нужно выбрать объект, в нашем случае 

 
Рисунок 2.55 – Создание зоны обработки 
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это грань детали перпендикулярная плоскости эскиза, в командной строке появится запрос на величину смещения, а 
на выбранном объекте появится стрелочка, указывающая направление смещения (рис.2.59). Если выбранное 
направление нас не устраивает, его можно поменять, введя отрицательное значение величины смещения. 

 
Рисунок 2.59 – Использование эквидистанты при создании эскиза 

После того как эскиз создан, можно выйти из него. Система предложит указать способ выдавливания, выбираем 
Up to Surface>Dune («вверх» до выбранной поверхности), после чего необходимо указать поверхность, до которой 
осуществляется выдавливание, в нашем случае это нижняя поверхность заготовки (рис. 2.60). 

 
Рисунок 2.60 - Использование операции выдавливания для создания зоны обработки 

Нажимаем ОК в окне создания выдавливания и переходим в окно Menu Manager. Теперь необходимо создать 
зону обработки, располагающуюся внутри детали. Эта зона обработки создается как и предыдущие. Если необходимо 
отредактировать какую-либо зону обработки нужно в дереве построения на данной обработки вызвать контекстное 
маню, выбрать в нем пункт Edit Definition. После чего появится окно операции, при помощи которой была создана 
данная зона (рис. 2.61). 

В этом окне мышкой выбирается стадия создания операции. Например, 
выбрав пункт Attributes, можно изменить направление выдавливания, сделать 
его одно или двухсторонним. Выбрав пункт Section можно изменить 
плоскость эскизирования или сам эскиз. Выбрав пункт Depth можно изменить 
способ выдавливания. 

Создание каждой из зон обработки отображается в дереве построения 
(рис. 2.62) 

Совокупность всех трех зон 
представляет собой единое твердое 
тело (рис. 2.63).  

Рисунок 2.61 – Окно создания 
операции выдавливания 

 
Рисунок 2.62 – Дерево построения 
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После того как все зоны обработки созданы, можно 
перейти к следующему шагу. Необходимо создать траекторию 
движения фрезы в пределах выбранной зоны обработки. 
Выбираем Machining>NC Sequence>Done (при указанных 
Volume и 3 Axis)> Done. Выбираем следующие установки (рис. 
2.64): 

Выбираем Done. 
Появляется окно выбора 
инструмента (рис. 2.65). 

 
Рисунок 2.65 – Окно выбора инструмента 

В этом окне можно выбрать созданный ранее инструмент, создать новый инструмент или внести коррективы в 
созданный ранее. После выбора основных параметров (диаметр длина инструмента) нажимаем Apply>OK. В окне 
Menu Manager выбираем Set, появляется окно Param Tree, в котором устанавливаются основные параметры обработки 
(рис. 2.66). Окно работает как таблица. Напротив нужного параметра указывается его значение. 

 
Рисунок 2.66 – Окно выбора параметров обработки 

 
Рисунок 2.63 – Совокупность зон обработки 

 
Рисунок 2.64 – Окно Seq Setup 
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В верхней части окна есть строка Input, с помощью которой можно выбирать значения некоторых параметров. 
Для этого нужно выделить строчку, содержащую значение данного параметра, а затем обратится к строке Input и при 
помощи галочки выбрать необходимое значение. После занесения параметров выходим из этого окна и в окне Menu 
Manager нажимаем Done. Из окна Param Tree можно выйти, не заполняя графы, но в этом случае система будет 
навязчиво предлагать ввести их в командной строке, не давая возможности выполнить какое-либо другое действие. 
Вот параметры обязательные к заполнению: CUT_FEED – подача резания (мм/мин), STEP_DEPTH – величина шага 
(глубина резания, мм), STEP_OVER, SINDEL_SPEED – частота вращения шпинделя (мин-1), CLEAR_DIST.  В графе 
SCAN_TYPE можно выбрать траекторию движения фрезы, например по спирали. 

Необходимо создать еще одну плоскость – плоскость безопасности, отстоящую от самой верхней точки 
заготовки на определенном расстоянии. Появляется окно Retract Selection. В нем выбираем кнопку Along Z Axis, и 
указываем расстояние, на котором плоскость безопасности будет отстоять от рабочей зоны (рис. 2.67). 

После нажимаем Select, выбираем плоскость, нажимаем ОК. 
Выбираем Select Vol, указываем зону обработки (рис. 2.68). 

 
Рисунок 2.68 - Указание объема удаляемого материала 

После этого нажимаем Done Seq. В дереве построения 
отображается созданная траектория обработки (рис. 2.69). 

Теперь можно 
перейти к симуляции 
процесса. Выбираем CL 

Data>NC 
Sequence>название 

обработки (по умолчанию 
Volume Milling)>Done. 
Появляется окно Play 
Patch (рис. 2.70). 

В окне плеера можно посмотреть 
траекторию движения фрезы. Помимо 
стандартных кнопок воспроизведения (вперед 
и назад) и перемотки присутствует 
регулировка скорости воспроизведения, 
представленная в виде ползунка. Чем левее 
расположение ползунка, тем медленнее 
скорость воспроизведения движения фрезы 
(Slow), чем правее ползунок, тем быстрее 
движения фрезы вдоль траектории (Fast). 
Помимо этого в плеере присутствует кнопка 
Tool Clearance, которая позволяет 
моментально просмотреть всю траекторию 
движения фрезы. Присутствует так же кнопка 
Position Cutting Tool, нажав на которую можно 
позиционировать инструмент в пределах зоны 
обработки. Мышкой указывается точка на 
траектории, с которой пользователь хочет 
начать просмотр движения фрезы (рис. 2.71). 

 
Рисунок 2.67 – Выбор плоскости 

безопасности 

 
Рисунок 2.69 – Отображение в дереве 

построения создания траектории 

Рисунок 2.70 – Окно плеера 
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Для начала просмотра необходимо нажать кнопку Play.  
На рисунке 2.71 показана точка, в которой будет 

располагаться инструмент и кусочек траектории, на котором 
расположена точка. 

Итак, была проведена черновая обработка при данном 
установе детали. Теперь можно заняться чистовой 
обработкой. Чистовую обработку проведем с 
использованием функции Surface Mill (поверхностное 
фрезерование). Выбираем Machining>NC Sequence>New 
Sequence>Surface Mill (при установленной 
трехкоординатной обработке). В появившемся окне 
выбираем следующие пункты (рис. 2.72): 

В окне Tool Setup 
выбираем инструмент. 
Выходим из окна Tool Setup 
нажимаем Set. В окне Param 
Tree указываем параметры 
обработки (рис. 2.73). 

 
Рисунок 2.73 – Окно параметров обработки 

Нажимаем Done>Model>Done>Add и указываем поверхности подлежащие 
обработке. Если поверхностей несколько их нужно выбирать в том порядке в каком будет проведена обработка. Для 
одновременного выбора нескольких поверхностей необходимо зажать Ctrl (рис. 2.74). 

 
Рисунок 2.74 – Выбор поверхностей подлежащих обработке 

После выбора поверхностей появляется окно Cut Definition (Окно определения положения инструмента) (рис. 
2.75). 

 
Рисунок 2.71 – Использование функции Position 

Cutting Tool 

 
Рисунок 2.72 – Выбор 

параметров 
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В верхней части окна выбирается тип обработки: прямое резание (Straight 
Cut), поверхностные изолинии (From Surface Isolines), линейное резание (Cut Line), 
проектируемое резание (Projected Cuts). От выбора типа резания зависит нижняя 
часть окна. Выбираем пункт From Surface Isolines, нажимаем ОК> Done Seq. 

Взываем плеер для просмотра траектории CL Data>NC Sequence>Surface 
Milling>Dune (рис. 2.76). 

 
Рисунок 2.76 – Просмотр траектории движения фрезы 

Теперь поведем фрезерование детали с другого установа. Существенных изменений в создании данной 
обработки нет. Вставляем модель детали, создаем заготовку (состоит из двух частей). Указываем параметры станка, 
инструмент, машинный ноль, создаем зоны обработки (рис. 2.77). 

После этого создаем траектории обработки (две Volume одну 
Surface Mill). И осуществляем просмотр траектории в плеере (рис. 
2.78). 

 
Рисунок 2.78 – Просмотр траектории в плеере 

Для симуляции обработки Pro/Engineer использует интегрированную программу VERICUT. Для запуска 
симулятора необходимо в окне Menu Manager выбрать CL Data>NC Check. 

Для получения управляющей программы необходимо в окне Menu Manager выбрать CL Data>NC Sequence, 
выбрать в списке переход, затем нажать File>MCD File>Done (рис. 2.79). 

Система предложит сохранить файл с расширением .ncl (рис. 2.80). 

 
Рисунок 2.80 – Сохранение файла 

Нажимаем ОК, в окне Menu Manager нажимаем Done, выбираем постпроцессор (рис. 2.81). 

 
Рисунок 2.75 –  Cut Definition 

 
Рисунок 2.77 – Зона обработки 

 
Рисунок 2.79 – Создание файла с УП 
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Появится информационное окно, сигнализирующее о создании файла 
(рис. 2.82). 

 
Рисунок 2.82 – Информационное окно 

Управляющую программу можно посмотреть при помощи блокнота, 
для этого нужно найти созданный файл с расширением .lst (имя файла 
соответствует имени созданного файла с расширением .ncl). Управляющая 
программа в более привычной форме содержится в файле с расширением 
.tap, имя этого файла аналогично созданному. Фалы с расширениями .lst, 
.ncl, .tap расположены в оной папке. Рекомендуется сохранять эти файлы в 
отдельной папке, во избежание путаницы. Файл УП приведен на рисунке 
2.83. 

 
Рисунок 2.83 – Файл УП 

Распечатка УП приведена в приложении. 

2.5    Основные настройки интерфейса в Pro/Engineer Wildfire 2.0 
 

Изменение цвета детали 
Цвет детали можно поменять следующим образом: выбираем в меню Вид>Параметры модели>Освещение . В 

окне «Редактор освещения» выбираем пункт Цвет и переходим в окно «Редактор цвета» (рис. 2.84). 
В окне три закладки: Цветовой круг, Палитра смешивания и 

Цветовые модели RGB/HSV. В последней закладке регулировка цвета 
осуществляется при помощи ползунков, при этом на детали 
устанавливается один цвет (в модели RGB и (или) HSV) (рис. 2.84). В 
закладке Цветовой круг цвет выбирается интерактивно (рис. 2.85). При 
использовании палитры смешивания цвет устанавливается как нечто 
среднее среди четырех цветов, расположенных по краям палитры. Для 
установки каждого из цветов необходимо выделит зону (верх, низ, 
право, лево) и выбрать цвет в закладке Цветовые модели RGB/HSV 
(рис 2.86). 

 
Рисунок 2.81 – выбор постпроцессора 

 
Рисунок 2.84 – Редактор цвета 
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Рисунок 2.86 – Палитра смешивания 

 
Изменение системных цветов 

Для изменения системных цветов необходимо выбрать меню Вид>Настройка изображения>Системные цвета 
(рис. 2.87). 

В этой закладке основными настройками можно считать графу «Фон» и 
«Смешанный фон». Графа «Фон» отвечает за цвет фона в режиме эскиза. По 
умолчанию система предлагает темно-коричневый цвет. Изменение цвета фона 
осуществляется, так же как и у детали (ползунками). Графа «Смешанный фон» 
отвечает за цвет фона в области моделирования. По умолчанию система 
устанавливает серо-белый градиентный фон, его можно изменить, нажав кнопку 
«Правка» и выбрав верхний и нижний цвет (рис. 2.88). 

 
Рисунок 2.88 – Установка градиентного фона 

 
Отображение опорных элементов 

Наличие большого количества опорных плоскостей и осей 
«засоряет» изображение модели. Для того чтобы убрать их 
отображение на экране нужно выбрать: Вид>Настройка 
изображения>Опорные элементы (рис. 2.89). Чтобы убрать все 
плоскости оси или точки нужно снять галочки напротив 
соответствующих пунктов в окне «Опорные элементы». А если 
потребуется выбрать какую-либо плоскость для построения 
эскиза, то это можно сделать в дереве построения. Активировать 
и дезактивировать отображения плоскостей, осей, точек можно 
при помощи иконок, расположенных  на панели инструментов 

. 
 

Отображение модели 
Для повышения (понижения) качества отображения 

модели используется окно «Отображение модели». Необходимо 
выбрать: Вид>Настройка изображения>Отображение модели 
(рис.2.90). В закладке «Ребра/Линии» можно выбрать качество 
ребер (низшее, среднее, высокое, высшее). В закладке 

 
Рисунок 2.85 – Выбор цвета при помощи цветового круга 

 
Рисунок 2.87 – Выбор 
системных цветов 

 
Рисунок 2.89 – Отображение опорных элементов 
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«Тонирование» можно выбрать качество тонирования (в пределах от 1 до 10). 
Атрибуты видимости 

Для выбора атрибутов видимости необходимо нажать: 
Вид> Настройка изображения>Видимость. Откроется окно 
«Атрибуты видимости». В нем можно выбрать степень гашения 
модели и срез по глубине (рис. 2.91). 

Срез по глубине представляет собой некое 
подобие динамического сечения, регулируется при 
помощи ползунка или окошка, в котором отображен 
процент среза. Стоит заметить, что срез зависит от 
положения детали, то есть в другом положении срез 
будет иным (рис. 2.92). 

 
Рисунок 2.92 – Срез по глубине 

 
 

  
Рисунок 2.90 – Окно «Отображение модели» 

 
Рисунок 2.91 – Окно «Атрибуты видимости» 
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3   Технологическая часть 
 

3.1 Служебное назначение детали 
 
Деталь является частью заказа одного из российских заводов. Заказ включает в себя изготовление 

формообразующих элементов трех деталей: правого и левого полукорпуса и крышки. Данные детали собираются 
совместно с другими деталями и в совокупности образуют прибор ночного видения. Формообразующими элементами 
для изготовления полукорпуса являются: матрица неподвижная, пуансон, подвижная матрица. Неподвижная матрица 
и пуансон предназначены для образования поверхностей пластмассового полукорпуса. Подвижная матрица 
предназначена для подъема пуансона при размыкании пресс-формы и извлечении детали. Материал 
формообразующих элементов сталь 40Х. Химический состав представлен в таблице 3.1 

 
Таблица 3.1 – Химический состав формообразующих элементов 

S P C N Si Cu Ni Cr Mn Не более 
0,36…0,44 0…0,008 0,17…0,37 0…0,3 0…0,3 0,8…1,1 0,5...0,8 0,035 0,035 

 

3.2   Выбор исходной заготовки и метода ее получения 
 
Конструкция деталей предусматривает на данный момент времени один способ получения заготовки: 

вырезание. Заготовка представляет собой параллелепипед, размеры которого зависят от основных габаритных 
размеров и припусков. 

3.3   Расчет промежуточных размеров с использованием программы KON 7 
 
Расчет припусков проведем для неподвижной матрицы. Расчетная схема имеет вид (рис. 3.1): 

Граф представлен на рисунке 3.2. 

 
Рисунок 3.2 – Граф 

Входим в программу KON 7. Вводим общие данные 
(рис. 3.3). 

 
Рисунок 3.1 – Расчетная схема 
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Рисунок 3.3 – Общие данные 

Указываем конструкторские размеры (рис. 3.4). 

 
Рисунок 3.4 – Конструкторские размеры 

Указываем припуски (рис 3.5). 

 
Рисунок 3.5 – Припуски 

Укажем размеры заготовки (рис. 3.6). 

 
Рисунок 3.6 – Размеры заготовки 
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Приложения 
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